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Chromebooks
Speaker: Dr. Ronald Brown, Director
Silvercom Computer and Technology Club,
Mesa Arizona
Are you looking for a computer that isn’t
complicated to use? How about one you
can’t wreck by making a mistake from the
keyboard? No maintenance, malware,
Trojans, and viruses? No subscription
cost and it’s always up-to-date with web technology?
The Chromebook is for you!
Chromebooks are relatively inexpensive laptops and tablets manufactured by the usual companies that use the
Google Chrome operating system (not Windows) and
many other Google and Android programs. Your data is
stored in the Google Cloud and can be instantly restored
if it is lost on the device. The software, utilities and data
of your Chromebook and Android phone are automatically kept up to date and synced.
Meet Our Presenter
Dr. Brown spoke to us on January 9 on Google Photos.
He received his M.D. degree from the University of
Alberta in 1976. He was a Family Practitioner on Vancouver Island and bought an interest in a start-up software company in Calgary that made an Electronic Patient Record. The company grew, and he represented it
at conferences in Canada and the U.S. for 20 years.
After he retired from medicine and the company, he settled in Arizona but kept his summer home in British
Columbia. He loves technology and spends his spare
time doing presentations.

Tuesday, May 8, 2018, 7:30 - 9:00 PM

www.apcug2.org
www.facebook.com/APCUG
www.twitter.com/apcug
www.youtube.com/apcugvide

Westchester United Methodist Church, Fellowship Hall
8065 Emerson Ave., Westchester, L.A. 90045
An informal Computer Q & A Roundtable meets from
6:30 to 7:20 to answer individual questions.
Refreshments and socializing at 7:00
More info: www.lacspc.org
or at 310-398-0366
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FROM YOUR EDITOR
Elliott Stern passed away
at the end of March,
2018. He was a member
of LACS from about
2014-2016, and he
served as treasurer in
2015. He was on the
APCUG Speaker's Bureau, had given an
excellent presentation to LACS in April
2014 on Computer backups, and he was a
speaker for APCUG Virtual Technology
Conferences.
Tulips in Shanghai

Photo by Leah

Happy Spring to
LACS Members.
Secretary Needed
LACS is in desperate need of a secretary.
The secretary writes and keeps the
minutes of the board meetings on the
first Monday of each month. Board
members will help you and answer any
questions. As a member of the board,
you will have input on the future of
LACS. Officers who are doing other
tasks now have to write the minutes,
too. Is that fair?

LACS Website
www.lacspc.org posts back copies of the
color version of User Friendly, calendar
information, and podcasts of most of our
general meetings. There is also a biannual index to past issues on the website.
Check the menu on the right side.
URLs are clickable in the online version
of User Friendly.

He was the owner of Maestro Computing
Services, so named because he could
make your computer "sing". He had been
servicing computers since 1985.
Elliott will be missed by many.

FREE 2018 SPRING VIRTUAL
TECHNOLOGY CONFERENCE (VTC)
SATURDAY, MAY 5
10:00 am – 1:00 pm PDT
REGISTER AT:
http://bit.ly/ May5VTCRegistration
DOWNLOAD THE CURRENT VERSION
OF ZOOM:
https://zoom.us/download
DETAILED INFORMATION ABOUT THE
PRESENTATIONS AND
PRESENTER BIOS:
https://apcug2.org/apcug-2018- springvirtual-technology- conference-vtc28/

The Editor of User Friendly accepts contributions of any suitable length from members. Send articles to
Leahjc(at)sbcglobal.net as plain text in an
email message or as a Word document by
the 20th of the month.
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IN MEMORIAM
Karl Springer
March 6, 1934 to April 13, 2018
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corrections to the lists and was a member
of the Mail List Moderator team. He was
known as the “Mail Guy”.
Karl led the question and answer forum before every general meeting where he helped
members with their computer questions
and problems. He was a faithful volunteer
at the Culver City Senior Center Computer
Lab.
Karl was preceded in death by his wife in
1976; his parents, Lena and Max; stepmother, Clara; brother, Paul; and sisters,
Sr. Ellen and Sr. Agnes (née Margaret).

Karl Eugene Springer, 84, passed away on
April 13, 2018 in Culver City, California.
Karl was born in Chicago, Illinois on March
6, 1934. He earned a bachelor of Engineering
degree from Marquette University in Milwaukee, WI in 1956 and a master's degree from
USC in 1958. Karl married Cleoria ("Cleo")
Antoinette Serritella on February 1, 1958.
They were married for eighteen years. Karl
and Cleoria had one son, Kyrt, in October
1959.
Karl worked as an electrical engineer at
Hughes Aircraft for thirty-three years. He was
involved with the Trailblazers Square Dance
Club and joined the Los Angeles Computer
Society in December 1991. He enjoyed square
dancing and computers.
For 27 years in LACS, Karl performed many
services that kept the organization highly
functional. He worked quietly in the background: members may not have been aware
of all he did. Using his skills with FTP and
HTML, he maintained the LACS website by
keeping the “Contact Us” pages up-to-date,
uploading the newsletter and meeting notices, and making any needed changes. Karl also maintained the LACS Yahoo! Groups mail
lists by adding new and dropped members to
the two main lists and other special lists. He
notified the membership chair of changes and

Karl is survived by his son, Ky; daughterin-law, Stacy; and nephews, Jim, Tom, Bill,
and Pete.
In lieu of flowers, memorial donations may
be made to: Congregation of the Sisters of
St. Joseph or the Juvenile Diabetes Research Foundation.
The family wishes to thank
 Always Best Care
 The Los Angeles Computer Society
 The Trailblazers Square Dance Club
 St. Jerome Roman Catholic Church.

LACS Members' Tributes to Karl
Paula Van Berkom
Karl was the backbone of LACS. He worked
behind-the-scenes and made sure everything kept running smoothly.
He was my dear friend, my mentor, the
backup for the website and many more. He
was an old-time DOS guru!
He surely will be missed.
Bobbi Gold
Despite his increasingly frail health, Karl
was always delighted to supply helpful information to anyone’s questions. I was often amazed that no matter how obscure the
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question, Karl knew something about it and
was happy to share it. He was one of the
many generous members who kept LACS
functioning.
Carol Johnson
Yes, Karl will be missed. I have missed him
already.
Ros Cirlin
Thanks, Karl, for your constant contributions to LACS. I'll never forget you. In the
late 90s, Karl Springer served on the Membership Committee, as did Charlie Semple,
Gene Jacobs, Paul White and
me. Stephanie Nordlinger would attend
from time to time.

Maurice Stephenson
As a former President of LACS, I truly enjoyed working with and knowing Karl. Karl,
Leah, the other Members of the Board and I
worked very closely and tirelessly, for two
years, to ensure that LACS continued its
excellence and scholarship. Karl was always polite, respectful and dedicated, a
true model of the best of his generation. I
will always be grateful for his support and
direction. May his family be comforted by
our love and caring, and may Karl rest in
peace!
Stanley Johnson
I’m truly sorry to hear about Karl’s passing.
He contributed so much to our organization. He handled many technical responsibilities, including updating the website and
managing our email lists. He diligently
held board members and officers accountable for decisions. His absence is a great
loss. I’m grateful for the opportunity to
work with him.
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Stephanie Nordlinger
Karl was always eager to help – even quite recently when he was very seriously ill (waiting
for heart surgery, etc.) and we were trying to
figure out how to do some of the tasks he had
done for us for years. He was smart and
cheerful to the end. He will truly be missed.

Charlotte Semple
With deep sorrow, I send my thoughts to all
of you. Karl, as Charlie, was one of the
backbones of LACS. Lately, when I attended a
General Meeting, I felt something was missing
- Karl was not there. With his quiet dignified
demeanor, putting everyone at ease, answering any question asked of him, giving knowledgeable advice. Yes, he will be sorely missed.
He fought the good fight to stay, but, I guess
Our Lord needed him. I send my love and
condolences to everyone and his family.
Fred Kong
Unseen usually, quiet in the background, but
always ready with an answer when asked.
And the answers he gave along with the
wheres and whys were just always right!
We've lost another of our giants! We miss
them all so much.
Leah Clark
Karl was a very kind, generous and cheerful
man, always seeing the positive in each situation. He was my go-to person when I was having any problems with email or mail lists, or
needed help with links in User Friendly. I am
wondering now if I can pray to him in heaven
to help me?
Gilbert Ialongo
The MailGuy will be delivering mail from the
sky. I have first met Karl when I joined LACS
more than 15 years ago. He was a powerhouse at the club and his participation in the
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Society activities and functioning was remarkable and mostly behind the scenes. He was
the one I could talk to about DOS, share
Batch files and obscure but important utility
programs. Now all of that is gone. Karl,
thanks for all the great work for LACS.
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Founding Fathers convert handwritten
docs to digital format. I can just see John
Hancock being shown how to increase the
font size and being shown 'Bold'. I can also
imagine Karl, with his smile, enjoying Mr.
Hancock's look of joy. 

Howard Krivoy
I knew Karl from square dancing, long before I
joined LACS. Karl liked to dance at the higher,
more intricate levels and was also always
a helper at the beginners' classes. Only recently did I learn that, like at LACS, he was
actively supporting their web pages. He was
the same easy going, likeable Karl that we
knew at LACS. Both organizations are better
for having known him. Rest easy Karl, you've
earned it.

Mark Presky
Karl had a wry sense of humor and a Cheshire Cat sort of smile. He tended to be a quiet
sort of guy and seemed to prefer to work in
the background. When called upon, he was
always there to help, but you never heard
much about it - again, he was unassuming.
He introduced me to several solutions to problems, including Go Daddy personal domain name registration. I might not be
mark@markpresky to some of the world if it
weren't for him.
I have been missing him at the meetings, and
should have realized sooner why he
wasn't able to make them for so long. I really
miss him. I hope that he is now with Charlie,
Henry, Meyer, Todd, and the others from
LACS that have moved on and who I was privileged to have known. I imagine that where
they are, there are no computer problems as
every computer and program updates itself
seamlessly in the background without fanfare,
and there are no computer glitches or failures.
In fact, they're probably helping the U.S.

OPEN A DOCUMENT AFTER A FILE
CORRUPTION ERROR
Sometimes a file can be damaged in such
a way that Word, Excel, or PowerPoint
can't open it normally. But all is not lost.
The Open and Repair command might be
able to recover your file.
1. Click File > Open, and then go to the
location or folder where the document
(Word), workbook (Excel), or presentation (PowerPoint) is stored. Don't try to
open the file from the Recent section as
this won't go into the Open dialog box.
Note: Word, Excel or PowerPoint 2007
don't have a File tab. Instead, go to
the Office
button, and click Open.
2. Click the file you want, then click
the arrow next to Open, and click
Open and Repair. 
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GENERAL MEETING REPORT
April 10, 2018
By Leah Clark, LACS Editor
Speaker: Joe Melfi
Digital Camouflage - Virtual Private Networks
hen you are provided public Wifi in a
Starbucks or a restaurant is the best
case to be using VPN. Today it is pretty
easy to set up, to use, and it is affordable.
Joe Melfi told us why and where we should
use it. We need to keep our data private;
our privacy has been violated. Protections
like the Do-Not-Call list are ignored, and
there is no enforcement. We are responsible
to ourselves to protect our privacy. To be
secure, there is not just one thing to do. It
puts a heavy burden on the user. Google
Maps gets input from users to tell us where
there’s an accident, how long a trip will
take, etc. This is referred to as “Crowd
Sourcing.” That’s a benefit.

W

VPN is new and is changing. The business
world uses AAA security, that is Authentication, Authorization, and Accounting. As
private users, we want to borrow some of
the less complicated parts because the information we have in our computers about
our finances, our family, and our health is
our business and should be protected.
Who should be using VPN? It is something
everyone could use, but not necessarily
should use. It depends on your computing
habits. Joe pointed out things we can do to
protect ourselves in public environments.
That includes the smartphones that we
take everywhere. Everyone should be keeping their computer and software up-to-date.
Pop-ups that say that updates are available
can be scary. Often they are valid, but they
could be coming from bad people. Clicking
is a big danger! Our security software has
branched into other things to take care of
adware, malware, and phishing scams.
A firewall blocks stuff from the outside from
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coming into your computer. Your computer
should make a request, and things on the
internet should only respond to your request.
A firewall is efficient in monitoring the data
you request to come into your computer. It is
not 100% foolproof, so the router into your
house should have a firewall on it. Your router
and modem must be kept up-to-date. Your
provider takes care of it, but if you have an
old router, the technology may not be updated
anymore.
If you are in your house, and you get service
from your provider, that’s a private network. If
you go to a library, a coffee shop, or any
shared network, that’s public. If there is no
password required, it is open. There is very
little protection in a public network. We can’t
depend on the government to protect us. They
just repealed Net Neutrality and other things
that opened up the internet to be a sham gallery. Your internet provider now can monitor
everything you’re doing and use it for any purpose they want, and it can resell it to third
parties. Those third parties can do whatever
they want with it. They get away with everything by requiring you to click that “you agree
to these terms.” Permissions to steal our data
should not be a requirement for service!
We have two users who are trying to communicate with each other. Something happens to cause the direct communication to be
interrupted. Someone has inserted himself in
the middle. If you’re at a Starbuck’s and see
several Starbuck's networks listed, you select
the strongest one. Only one might be valid.
The one you selected is “a man in the middle”
recording everything you do. Ask for the right
way to connect.
A Packet Sniffer is a tool that records all the
data that comes across the network and tries
to decrypt it. It is free for download. So it
doesn’t take much for someone to start sniffing your data in a coffee shop.
Information over wireless has been improved
by using WPA (Wireless Protected Access) that
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encrypts the information wirelessly almost
anywhere, except open networks. Also, there
is Secure Socket Layer (SSL) which is supposed to encrypt all your traffic, but criminals
always seem to find a way to hack into it.
This is where VPN is going to help. It encrypts
some of the information that goes from your
device to the internet and back. VPN relies on
a principle called tunneling. Cryptography,
encryption, and protocols are the basis of
what makes your computer secure. VPN uses
all of these things and public keys, private
keys and certificates. The CA Certificate Authority issues certificates that authenticate
persons are who they say they are. If you own
the computer and log in with your credentials, you should be authenticated by your login, and your computer should authorize you
to do things on that computer. If someone
else should try to access your computer, they
should say, “No.” Accounting is where they
record a log of security events.
When Dave and Alice want to send messages
back and forth, they want them to be private.
Everything is made up of bits; so we scramble
up the bits. Anyone who sees the information
sees only scrambled bits. The receiving person’s computer must descramble them to
read the message. The sender and receiver
use the same algorithm to encrypt and decrypt. So they use a “key”, a numerical value
which comes from the certificate. It’s an
algorithm to scramble up whatever is in the
message. Because of the protocol in the certificate, the receiver’s computer knows how to
decrypt the message. It is a very complicated,
math-based system. The Transmission Control Protocol/Internet Protocol (TCP/IP) is a
protocol suite used for communication transmission. Joe went into more details of its history and function which you can hear on the
podcast of this presentation.
It is complicated to set up your own VPN, but
there are services to set this up for us.
https is the secure way of doing browsing.
When you open your browser, there’s an address bar at the top. Look for green lettering
on the left side and a lock icon with a closed
shackle to indicate you are at an authentic
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website. This goes back to the certificates.
You want data going across the internet to
be encrypted. One way to do that is to create a virtual tunnel using VPN. Endpoints
are the two devices that want to talk to
each other securely. The VPN client is one
endpoint, and the VPN server is the other
endpoint. A server runs the VPN protocol
that you need to connect to to be secure.
A person working from home logs into the
company network, and he does his work.
The company runs a VPN client on its devices that connects to a VPN server. A tunnel is created between these two endpoints.
Once data gets out onto the internet, it is
accessible anywhere on the internet. We
pretend that we have a direct connection
that no one else can see by creating a virtual private tunnel between two endpoints.
Today there are a lot of third-party programs that will setup VPN for us; some cost
money, and some are free to try. The internet browser, Opera, is a free browser with
VPN and a built-in ad blocker. They are
putting VPN into some anti-virus programs
that may be free trial teasers. Then there
are charges. Be wary of free programs there may be a catch.
The most important time to use VPN is
when on a public network. But even at
your house, it may be useful. Be sure to
clear your history, cookies, and cache when
done browsing. You should use a password
manager. You need a total solution to keep
secure.
For more benefits of VPN, like geofencing,
for pricing, available companies, etc. listen
to the podcast at https://www.lacspc.org/
Podcasts/VirtualPrivateNetworks.mp3
Joe suggested Private Internet Access (PIA)
as a good starting point. Look at their website to see if they provide what you need.
See the slides from this presentation at
https://apcug2.org/wpcontent/uploads/2
017/09/Digital_Camouflage_With_VPN_Joe
Melfi_APCUG_VTC-11-4-17.pdf 
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LACS NOTICES
WELCOME ALL
George Wolkon, LACS Database Manager
New Members (1)
Paul Taylor
Renewals (12)
Richard Balsam
Loling Beckman*
Guy Clark
Juan Dominguez
Patricia Downing
Roxanne Goodrich
*Contibutor

Carolyn Griswold
Robert Hirsho
Marcia Jacobs
Howard Krivoy
Marcia G. Maiten*
Patrick Zilliacus*

HOW TO CHANGE YOUR CONTACT
INFORMATION
Go to www.lacspc.org. Click on Member
Forms in the bar under the picture. Under
Membership Update, select Click Here for
either the DOC or PDF form. Fill it out and
bring it to a meeting or mail it. Or email
your changes to
membership@lacspc.org.

FIX YOUR PC FOR FREE?
Jim McKnight has an open offer
to all LACS members to diagnose, repair, disinfect, or upgrade members' PC’s for free.
There are certain limitations to Jim’s offer, so
see the details by clicking the “Fix my PC for
Free?” link at www.jimopi.net .
Non-members can wisely invest in a oneyear new Regular LACS membership
($40.00), and Jim will fix your PC problem,
too. Contact Jim for specific considerations.

GENERAL MEETING PRESENTATIONS
May 8
Chromebooks
June 12 Become Your Own Computer Expert
July 10 Google Apps at Home and on the Go
Note: This schedule is subject to change.
Check your email, User Friendly, and our
website for updates.

PODCASTS
LACS HAS JOINED MEETUP
Our Meetup group is called:
"Los Angeles Computer Society and
Technology Meetup."
Please join - it's free. If others see that a
lot of people are interested, they will be
encouraged to join LACS. We hope this
will result in new members.
Go to http://www.meetup.com/LosAngeles-Computer-Society-andTechnology-Meetup/
and click on "Join Us." Also, RSVP for our
general meetings.

LACS IS ON TWITTER

On Twitter, follow us at:
https://twitter.com/LA_CompSoc
The LACS board voted to discontinue the
Facebook page for now.

Listen to the podcasts of our general meetings. Go to http://www.lacspc.org/
category/audio-files/. Click on the session
you want to hear.

GENERAL MEETING SNACK SCHEDULE
By Sylvia Q. Davis, Hospitality Chair
Refreshments and socializing will be at 7:00,
with the meeting starting at 7:30. Please
bring refreshments at 7:00.
May 8
O through S
June 12
T through Z
July 10
A through D
August 14
E through I
September 11 J through N
October 9
O through S
Bring finger-food treats such as fresh fruit,
veggies, nuts, cookies, cold drinks and the
like. LACS provides hot drinks.
See your email for updates and reminders.
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MAY 2018
Sunday

Monday

Tuesday

1 May

Wednesday Thursday

Friday

Saturday

2

3

4

5

9

10

11

12

Day

6

7

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

Board
Meeting
7:00 PM

8

General
Meeting
7:30 PM

No SIG meeting is scheduled for May.
This Calendar may change.
Check your e-mail or with the SIG leader before attending a meeting.
General Meeting: Fellowship Hall on the 2nd Tuesday of the month at 7:30 PM.
The Board may meet at Charlotte Semple's home or at Santa Monica College. Members in
good standing are welcome to attend.

SPECIAL INTEREST GROUPS (SIG's)
The Daytime and the Basics & Beyond SIGs may resume IF there is enough interest. Please
contact the leaders to make your wishes known, or to offer ideas or help. New SIGs can be
created if there is sufficient interest and leadership.
Basics & Beyond SIG: Paula Van Berkom, 310-398-6734, 2nd Mon. 7 PM SMC, Bundy
Campus
Daytime SIG : Jim McKnight, 310-823-7829, 4th Tues. 1 PM Felicia Mahood Center

ADDRESSES
Felicia Mahood Senior Center, 11338 Santa Monica Blvd., West LA 90025 (at Corinth)
Fellowship Hall, Westchester United Methodist Church
8065 Emerson Ave., Westchester 90045
Charlotte Semple, 3474 Beethoven St. LA 90066

Santa Monica College Bundy Campus, 3171 S. Bundy Drive, LA 90066.
Go west on College Dr. (1 block South of Airport Avenue, 2 blocks North of Rose.) Drive to
the back to park in the lot behind the building. Our room number may change each semester. Look for it on a sign opposite the elevator on the first floor.
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MEMBERS HELPING MEMBERS
LACS members volunteer to help other members solve hardware and software problems by
telephone during the hours listed below. Select the topic from the list and then call a
person whose number is listed next to it. Or you may use a Helper’s e-mail address, found
in your LACS Roster. We hope that you find this free service useful. If you are experienced
using a particular program or topic, please volunteer to be a consultant. You don't have to be
an expert. To volunteer for this list or to make corrections, please e-mail or call Leah Clark
at Leahjc (at) sbcglobal.net or at 310-677-2792. More Quick Consultants, and more categories are always needed. You may decline or postpone a call if it comes at an inconvenient
time.
Adobe Creative Suite: PDF,
InDesign, PhotoShop, etc. - 17
Android Smartphones - 5
Apple devices - 15
Anti Malware - 12
Digital Imaging, Editing - 8
Digital Photography - 8
Dragon Naturally Speaking - 4
Genealogy - 5, 7
Hardware - 12

Photoshop - 17
QuickBooks -18
Quicken - 3, 5
Thunderbird - 12
Visual Basic - 13
Websites - 13
Windows 7 - 16
Windows - 5, 12
WordPerfect - 5

Linux - 11
Lotus Word Pro, Approach - 12
Mozilla Firefox - 12
MS Excel - 3, 15
MS Word - 3, 4, 10
MS Outlook - 5, 15, 17
MS PowerPoint - 15
MS Publisher - 7
Open Office - 16

Name

Preferred Phone
for Calls

From

To

3

Wilder, Joan

310-472-8445

9:00 AM

9:00 PM

4

Hershman, Irv

310-397-9453

11:00 AM

11:00 PM

5

Nordlinger, Stephanie

323-299-3244

10:00 AM

7:00 PM

7

Clark, Leah

310-677-2792

7:00 AM

5:00 PM

8

Silverstein, Elliot

310-670-1544

10:00 AM

10:00 PM

10

Beckman, Loling

310-471-7893

10:00 AM

6:00 PM

11

Hughes, Bill

424-259-1818

Any

Any

12

McKnight, Jim

310-823-7829

8:00 AM

7:00 PM

13

Ialongo, Gilbert

310-641-7906

9:00 AM

5:00 PM

15

Van Berkom, Paula

310-398-6734

9:00 AM

5:00 PM

16

Johnson, Carol

310-372-8535

10:00 AM

9:00 PM

17

Rozek, E. J.

310-823-3811

Noon

8:00 PM

18

Semple, Charlotte

310-398-5052 M-F

9:00 AM

5:00 PM

No.
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OFFICERS, DIRECTORS AND LEADERS
Title
President
Past President
Vice President
Secretary
Treasurer
Director
Director
Director
Director
Director
Director
APCUG Rep.
Car Pool Coordinator
Change of Address
Corporate Counsel
CCSC Computer Lab
Hospitality Chair
Asst. Hospitality Chair
Membership Database
Newsletter Editor
Program Chair
"
"
Publicity Chair
Publicity - Press
Quick Consultants
Webmaster
Welcome Chair
Asst. Welcome Chair

Name
Stanley Johnson
Maurice Stephenson
Stephanie Nordlinger
VACANT
Charlotte Semple
Leah Clark
Jim McKnight
E. J. Rozek
Annette Tossounian
Paula Van Berkom
George Wolkon
Leah Clark
Freda Sanders
George Wolkon
Stephanie Nordlinger
Loling Beckman
Sylvia Davis
Freda Sanders
George Wolkon
Leah Clark
Stephanie Nordlinger
Stanley Johnson
Annette Tossounian
Mark Presky
Leah Clark
Paula Van Berkom
Irene Mussack
Linda La Roche

Term
2018
2018
2018
2018
2018
2018
2018
2018
2018
2019
2019

Telephone
424-216-6984
310-625-0450
323-299-3244
310-398-5052
310-677-2792
310-823-7829
310-823-3811
310-559-2847
310-398-6734
310-459-2671
310-677-2792
323-230-3278
424-646-3410
323-299-3244
310-471-7893
213-924-4927
323-230-3278
310-459-2671
310-677-2792
323-299-3244
424-216-6984
310-559-2847
310-398-0366
310-677-2792
310-398-6734
310-672-3077
310-645-4546

Website

www.lacspc.org

Voice Mail
E-mail

1-310-398-0366
Webmaster
sitemaster (at) lacspc.org
ContactUs (at) lacspc.org Change of Address membership (at) lacspc.org

Newsletter Editor

Leahjc (at) sbcglobal.net

The ContactUs (at) lacspc.org address goes to our president and vice-president.
If the message is for another board member, they will forward it to the correct person.
To contact other officers, directors, leaders or members directly, members may use our roster
for phone numbers and e-mail addresses.
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Creating a Newsletter with Writer
By Joel Ewing, President
Bella Vista Computer Club, AR
Bits & Bytes, October
www.BVCompClub.org
president (at) bvcompclub.org

T

here are software applications designed
explicitly for creating formal publications, but many small organizations don’t
require newsletters with highly professional
formats, and secondly, many such groups
depend on volunteer editors who lack the
time to produce such a document, even if
they were able to afford the software.
The purpose of this article is to demonstrate that a few simple techniques with a
completely-free, open-source word processor, LibreOffice Writer, can be used to create a newsletter in 8.5x11 format which
looks reasonable with minimal effort. These
same techniques could, no doubt, be applied using MS Word, since there is considerable overlap in functionality between MS
Word and LO Writer, despite major differences in the user interfaces. But, if the object is to encourage someone who might
not have access to MS Office to become an
“editor”, the availability of free alternatives
is a definite plus.
The most common newsletter format is to
have a full-width header at the top of the
first page, followed by content on that and
following pages. Many people seem to find
it easier to visually follow an article that is
not full-page width, so typically the article
content uses a multi-column format with
two or more columns. There is multicolumn-format support in LO Writer and
also support for “frames”, which facilitates
creation of a header that follows different
conventions.
My personal preference is to go with two
columns for content. Dividing into more
than two columns complicates fitting larger
images within an article, and makes it
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more likely that long words or long URLs will
cause visual problems with line justification
and line splits.
The Header
This is the place to start. Although it will take
some experimentation and time to create, this
is also the part of the Newsletter that will be
relatively constant, with possible exception of
date, and can be cloned for future Newsletters. I like the header to dominate and be a
little wider than the default margins. I find a
width of 7.65” will still print reliably, but you
may want to verify that width will work if you
have a specific printer you use to make hard
copies of the Newsletter.
Start with a blank document. Then Insert→
Frame…
 Type: Set Width 7.65 inches
 Height Autosize
 Position Horizontal Center
 Vertical Top, Anchor To page
 Borders: all, Line Width 1.0 pt.
(adjust to taste-- you may want to adjust
Spacing to Contents, as this determines
the light-gray inset from the borders
where heading contents may be placed.)
 Area: may want to adjust Fill later
 Columns: should default to “1”. This will
give you an empty frame (Figure 1),
almost full-page width, high enough for
one line of text, but it will expand as content is added.
Figure 1
Start typing information into the frame.
Which lines come first, font used, font size,
and left-right alignment are variable and subjective. This text should include Title, various
organization information, date of newsletter,
etc. Keep text that you might want to position
or size separately as separate paragraphs
(followed by “Enter”).
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Figure 2
Just keying in the basic information using
default font and size choices gives the
result seen in Figure 2. It's not particularly
impressive!
Now comes the experimentation part – trying out different fonts, font sizes, font effects (bold, shadow, etc.) until you find
some combinations that appeals to you.
Starting from nothing may take some false
starts and an evolving design. In my case I
was trying to come as close as possible to
some historical versions of the Newsletter
that had been produced with other tools. I
used those as a guide. I finally settled on:
 Title: “URW Chancery L” size 60, bold,
with shadow
 2nd line “Liberation Sans”, size 11’
 Date: “Liberation Sans”, size 24, bold;
 Bella Vista… line: “Liberation Sans” size
14, bold;
 Highlands… line: “Liberation Sans” size
11, bold
 Website line: “Liberation Sans” size 10

Right-justifying the date, adding several

trailing blanks, and centering the next
two lines, gave this effect: (Figure 3)
On the final line, I want the Website left
justified and the Email right-justified,
which can’t be done automatically. The
simple solution is to insert enough
blanks to put the Email in the desired location. This is getting close. I would like
to have just a little more space above the
Website line. Select that line and format
the paragraph by adding 0.06 spacing
above the paragraph.
We have an image that normally goes in
the upper right corner of the heading that
has black lines on a white background.
Set the cursor at the end of the Title and
insert the image. It won’t go in the right
place, but manually click and drag it to
the upper right corner of the heading
frame. To make things slightly more elaborate, you can choose to modify the
“Area” properties of the frame to include a
light color fill, or in our case we have a
lightly-colored bitmap background of our
logo that we use on the web site which
can be specified, resulting in the following: (Figure 4)
Notice the white rectangle background
around the image is
not what was intended.
We need to instead use
a version of the image
where all the white

Figure 3

Figure 4
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areas are transparent. This can be done
easily with the free GIMP image manipulation utility (a tale for another day), by selecting all the white areas, inverting the selection, copying the selected pixels, pasting
as a new image and exporting that as a
PNG image. Deleting the original image
from the heading frame and inserting the
new version gives us the final version
shown in Figure 5. The fine guide lines
showing the borders of the image will not

Figure 5
be in printed nor seen on PDF versions of
the document.
As one final observation on the header, the
easiest way to update the Date in the header without upsetting the formatting is to
insert the cursor somewhere in the middle
of the existing date (to get the same formatting) type the new date, then deleted the
unwanted characters from the old date. If
you delete the old date first, you will likely
have to re-do all the font and size customization that was done for the date.
The Content
 Set the cursor below the heading frame,
right click, select Page…,
 Set the Page Style for left/right margins
of 0.75” (or possibly as low as 0.5”)
 Set Columns to “2”. I like a black Separator Line of 0.25pt, but that’s personal
preference. You should probably also
set a “Spacing” of at least 0.1” between
columns to get some visual separation.
Articles may either be copied and pasted
from some other source or manually typed
into the newsletter starting with the left
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column. I would recommend using a consistent article heading style and a consistent
font type and size. It is sometimes useful to
play with inter-line or inter-paragraph spacing, and perhaps even with font size to get an
article to fit in the available space.
I would find a heading style that is close to
what you want for article headings, modify the
style to force the desired font, font size, and
other heading options, and then consistently
use that style for all headings.
For separating articles, I
would recommend inserting a horizontal line
(Insert → Horizontal Line).
The action name is a little
misleading because what
it actually does is mark
the current paragraph
with a “horizontal line”
style which causes the paragraph to have a
bottom border drawn. That style can also affect paragraph font and size and line spacing,
which is not usually what you want for a paragraph of text. So, the proper usage of the
horizontal line (from painful experience) is: at
the end of an article, press Enter, type one
space (to get a non-visible paragraph of one
space), and then Insert the Horizontal Line at
that point, so it is at the bottom of that invisible “space” paragraph. You can edit the
“Horizontal Line” style to increase the width of
the horizontal line (it is the bottom Border) to
make it more pronounced or a different line
style, and you can adjust the amount of vertical space before and after the “Horizontal
Line” paragraph.
If you want to begin work on the right column
of a page before finishing the left, or if you
just want to force the column break to occur
at a better separation point, you can use Insert → Manual Break… and select “Column
Break.” You can similarly use Insert → Page
Break to force text to begin a new page before
the current page is full.
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Working with articles with images can be
tricky; LO Writer likes to “anchor” the images
to a paragraph which can limit how it can be
moved. If necessary you can alter the properties of the image to change how it is anchored. When the image is selected, the anchor point is displayed (an anchor icon) and it
may be moved to a different point in the article. Sometimes attempting to move the image
makes it fly to unexpected locations or even
disappear, at which point “undo” is your
friend. You can find many suggestions on-line
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about how to deal with images in Writer,
but none of the solutions are very elegant
or foolproof.
Experience with this article showed that
copying and pasting a single-column document into a two-column target does not
handle embedded images well. You are better off saving the images separately, deleting any images copied with the document,
and manually re-inserting the images at an
appropriate point so that they get properly
sized for the narrow er columns. 

Start of new column

Forced column break

A TALE OF TWO PRINTERS
By Greg Skalka, President
Under the Computer Hood User Group, CA
Drive Light, November 2017
www.uchug.org
president (at) uchug.org

I

t was the best of times, it was the worst of
times . . .

It was time to buy a new printer.
It seems that all the traditional computer input/output devices are falling out of favor.
The rise in popularity of the tablet computer
and now especially the smartphone have
played a major part in this. The previously
iconic combination of desktop computer,
monitor, keyboard, mouse and printer has
not been the norm in the personal computer/
tech world for some time. The laptop or notebook PC, which generally eliminates the need
for a separate display, keyboard and mouse,
has been outselling the desktop for quite
many years already. Now the ultra-portable

smartphones and tablets, with their integrated touch-screen displays, have surely
put monitor, keyboard and external pointing device sales in a steep decline.
Printer sales are also declining. I’m like
most people in wanting to cut back on the
amount of paper in my life, both to reduce
clutter and help the environment. I’d much
prefer a paperless life, where my bills and
financial statements come as downloaded
pdfs, rather than hard copies in the mail,
and my file cabinet of personal and financial data is a USB external hard drive.
Smartphones are helping in this trend.
More and more, tickets, coupons and other
identifying documents are being accepted
when displayed on a smartphone or tablet
screen, instead of having to present a physical piece of paper (barcodes have also
helped make this happen).

While my goal is to eliminate my home file
cabinets by scanning my existing paper
documents and insisting on electronic
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documents in the future, there are still
times when I do need to print. Some of the
continued interest in computer printing is
probably generational. I still own printers;
my adult children do not. Just as most millennials have “cut the cord” in their switch
from cable TV (or televisions in general) to
streaming content from the Internet, they
have also abandoned the personal printer.
My son and daughter, both in their late
20’s, each still own a laptop in addition to
their smartphones, but have no interest in
having a printer. They have no need to print
photos, preferring to post them online or
display them on their phones. The few hard
copies they need to make can be printed at
work, or at the copy center at Staples or Office Depot (or at Dad’s house).
I started my work life in the early 1980’s, so
I’ve witnessed the evolution of the personal
computer and the personal printer. I’ve
owned dot-matrix and daisy-wheel impact
printers, as well as ink jet and laser printers. When my children were young, they
had their own individual printers and desktop computers for school work, resulting in
four printers in the house. Every computer
needed its own printer as each stood alone
and disconnected in the days before the internet. Since the development of modern
home networking and networked printers,
my wife and I have been sharing a single
printer for the past eight years.
The HP OfficeJet Pro 8500 all-in-one network printer I bought for my wife in 2009
has always resided in the downstairs bedroom that is her home office. She uses it
weekly to print stock lists for her job as a
retail seed merchandiser. It is a printer /
scanner / fax machine in one unit, with a
single-sided scanner feeder in addition to
flat-bed scanning capability (it can automatically scan a stack of pages on one side
only). It can also automatically print double
-sided to save paper. It has a wired Ether-
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net connection to my home network, so I can
print to it from my “office” upstairs. It is not
so useful for me to run downstairs to scan, so
I have kept my old USB flat-bed scanner in
my office.
I still have an old HP Deskjet 5650 printer
and an Epson Stylus Photo R340 printer in
my office, but I’ve not used either in over eight
years and should probably get rid of them.
The Deskjet is old and slow, and I get better
quality for the few photos I need printed by
going to the photo center in Costco, rather
than using the finicky Epson. I also have a
Samsung ML-2510 low-cost black laser printer, but I don’t use it much. Laser printers use
heat to fuse powdered toner to the paper, and
this printer seems to generate quite a lot of
heat. I can feel an excessive amount of heat
coming off the top of the printer when it has
been on for just a few minutes, so to reduce
energy usage (and fire risk), I only leave it on
long enough to print.
One thing I have always wanted in a printer is
the ability to print on 11” x 17” paper. I have
this capability at my work and find it is really
useful when printing CAD drawings and diagrams, as well as large spreadsheets. Another
useful feature I’ve been looking for is the ability to scan double-sided originals automatically (this is a special feature of the scanner’s
document feeder). Late last year I saw an HP
OfficeJet 7740 all-in-one printer advertised
with a great price at Fry’s; it had both features, so I bought it as a birthday present to
myself. I planned to set it up in my office in
place of my scanner, so I would have printing
and scanning at hand. Unfortunately, my life
is often too busy, and so this new printer sat
in its box for most of 2017.
Over the years, the HP8500 printer served us
well with few issues. Occasionally the print
quality would drop, with blank streaks in the
printed output. Using its diagnostic software
to clean the print heads usually solved the
problem, though with time, multiple and more
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frequent cleaning cycles were needed. Finally,
this spring, even three head cleaning cycles
didn’t completely restore good print quality,
and the HP diagnostic software reported that
new print heads were needed.
With most HP printers I’d owned, the print
heads were part of the ink cartridges, so you
got fresh heads with each cartridge replacement. With the HP8500, the ink cartridges
were just ink reservoirs; the heads were separate replaceable modules. Despite their supposed simplicity, the HP940XL ink cartridges
it used still cost around $100 per set (three
color cartridges and one black). Even though
the two print head modules cost around $80,
I was happy enough with the performance we
had gotten out of the printer over the eight
years we had used it, and so bought a set.
Replacing the heads was easy to do, and at
first solved the problem completely. The print
quality was once again excellent. A month later, however, the printer abruptly stopped
working. It gave an error message that no
heads were installed, thus it refused to print
at all. I tried removing and reinstalling the
heads, with no improvement. Only then did I
go online to search on this fault and found
many other users with the same problem after replacing heads. The only solution reported by these users was to temporarily reinstall
the old print heads until they were recognized, and then swap the new heads back in.
Even this was not often a permanent solution;
some reported having to perform this swap
periodically. Since I’d listened to my wife and
thrown the old heads away right after installing the new ones, this solution was not
an option. Because a new printer’s cost was
not much more than another set of heads for
this one, it was time to go shopping.
My wife, of course, needed to print for her
work activities the next day, and it was too
late to get her a new printer that evening. Fortunately, I had the new HP7740 printer I had
bought for my own use but had not set up
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yet. The setup for
this network printer
was far easier than
the old HP8500 was
eight years ago.
Once the new printer was powered and
connected with an Ethernet cable to my
home network (it could also connect via WiFi), the printer software and drivers could
be installed easily from the HP website. The
software automatically searched for the
printer on my network and configured everything. Creating an HP printer account on
their site allows you to obtain an email address for the printer. Any emails sent to
that address are printed (up to 10 MB and
up to 10 attachments), making it easy to
print remotely or from any device that can
send emails, including smartphones, tablets and Chromebooks. I installed the software on her computer as well, so we could
both use my new printer.
Later that week we went printer shopping
for my wife and bought an HP OfficeJet Pro
8715 from Costco. It had all the features of
the HP7740 but had only one paper tray for
8.5” x 11” paper. It
was just as easy to
set up and, as a bonus, it uses the
same HP952XL ink
cartridges as the
7740. I set it up in place of the broken
HP8500 in her office, and she has been
happily printing ever since.
Our old HP8500 served us well for many
years. These two new printers provide
many new capabilities and are easier to set
up and use. Hopefully we can look forward
to many years of good use out of them as
well.

It is a far, far better printing situation than
I have ever known. 
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as of March 31, 2018
Charlotte Semple, Treasurer
Total Assets
Receipts
Member Dues
Total Gross Receipts
Expenses
Newsletter
Facilities Rental
Verizon Wireless
QuickBooks Repair
Presenter Travel
Total Expenses
Current Total Assets

$7,876.35
432.00
$432.00
164.10
60.00
50.08
59.95
98.30
$432.43
$7,875.92

SPECIAL OFFERS
Go to the APCUG website
https://apcug2.org/discounts-specialoffers-for-user-groups/ for discounts and
special offers for User Groups Members.
Avast Anti-virus and Acronis True Image,
as well as several book, media and training
sites, offer discounts, including the two
mentioned below.
Members can save at the
Pearson Technology websites:
InformIT, Cisco Press,
Pearson IT Certification, Que
Publishing, Adobe Press, and
Peachpit Press.
Code for print books: ITCOMMUNITY
Code for eBooks: DIGITALCOMMUNITY
See the latest books on digital imaging and
photography, gaming, animation, film and
video, post-production, audio, music technology, broadcast and theatre from
Routledge | Focal Press today! They offer
discounts to User Groups.
NOTICE
The columns, reviews and other expressions of opinion in User Friendly are the opinions of the writers
and not necessarily those of the Los Angeles Computer Society. LACS became a California non-profit
corporation on July 17, 1991. Its predecessor was
the UCLA PC Users Group.

Computer Sayings
1. Home is where you hang your @
2. The E-mail of the species is more
deadly than the mail.
3. A journey of a thousand sites begins
with a single click.
4. You can't teach a new mouse old
clicks.
5. Great groups from little icons grow.
6. Speak softly and carry a cellular
phone.
7. C:\ is the root of all directories.
8. Don't put all your hypes in one home
page.
9. Pentium wise - pen and paper foolish.
10. The modem is the message.
11. Too many clicks spoil the browse.
12. The geek shall inherit the earth.
13. A chat has nine lives. (Given that La
Chat in French means a Cat, this is
especially cute.)
COPYRIGHT © 2018
by the Los Angeles Computer Society, an allvolunteer, tax-exempt [IRC Section 501(c)(3)]
nonprofit California corporation. All rights reserved. User Friendly is published monthly. Subscriptions are included in membership dues. Reproduction of any material here by any means is
expressly prohibited without written permission,
except that other nonprofit User Groups may reprint LACS articles in substantially unaltered
form if credit is given to the author and this publication and an e-mail is sent to
leahjc(at)sbcglobal.net reporting the reprint information (user group and the name and date of the
publication). Product and company names are the
trademarks of their respective owners.
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MEMBERSHIP INFORMATION
Annual membership Dues:
Regular New and Renewal,
Printed Newsletter
$ 40
Electronic Newsletter 30
Family-Associate
12
Students
18
Contributor
50
Supporter
75
Benefactor
100
A subscription to User
Friendly is included with
membership.
Associate members are those
who live in the same
household or work at the
same address as a regular
member; they do not receive
their own subscriptions to
User Friendly, but may read it
on the LACS website. Students
must prove full-time status.

In addition to monthly general
meetings, members enjoy
these special benefits:
-- Monthly Newsletter
User Friendly. We publish
your article submissions or
free classified ads to buy or
sell your computer items.
-- Get FREE help by
phone from knowledgeable
members who are Quick
Consultants listed in User
Friendly.
-- Get help by email by
using our LACSLIST Yahoo
Group Mail List. Send your
questions by e-mail to
lacslist (at) yahoogroups.com
-- Receive important news
and announcements via
LACS’s Yahoo Group e-mail
lists.

-- Occasional product discounts, special offers, etc.
-- Special Interest Groups
(SIGs) on various topics may be
created to help you to learn, to
share interests, and to solve
your computer problems.
-- Information on training,
swap meets and trade shows.
-- Occasional Free software
and computer books, if you review them for User Friendly.
-- Rewards for recruiting;
LACS will extend your membership for three months for each
new regular member you recruit.
-- Annual Holiday Party
-- Field trips
-- Social Interacting with others who have like interests in
computers and technology.
-- Computer and Virtual Technology Conferences



New or Renewal Membership Application
Please bring your dues and this form to a meeting or mail them to:
Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802
[ ] New
[ ] Renewal
Please PRINT Clearly
[ ] With printed newsletter [ ] $40.00
[ ] Associate $12.00

[

[ ] Student - $18.00

] With electronic newsletter, not printed [ ] $30.00

[ ] Contributor [ ] $50.00 [ ] Supporter $75.00 [ ] Benefactor $100.00 [ ] Other $___
____________________________________________________________________________________________
Name: First
Last
____________________________________________________________________________________________
Name of Associate: First
Last
____________________________________________________________________________________________
Address:
____________________________________________________________________________________________
City, State, Zip + 4
____________________________________________________________________________________________
Preferred Phone:
[ ] Do not publish in roster
____________________________________________________________________________________________
Email:
Email of Associate:
___________________________________________________________________________________________
Did a member of LACS invite you to join? If so, who? If not, how did you hear about LACS?

Revised: July, 2017 ljc

Editor…..…………........... Leah Clark
Electronic Editor ........ Karl Springer
Indexer ……….…............. Leah Clark
Podcast Transcriber ... Irv Hershman
Photographer……...................Vacant
Proofreaders …........ Lance Hegamin,
Jim McKnight, Stephanie Nordlinger,
E. J. Rozek and Charlotte Semple

FREE!
Earn 3 months of free
membership for every new regular
member you bring in.

is published by the Los Angeles Computer Society.
11664 NATIONAL BLVD, #343 LOS ANGELES CA 90064-3802

DIRECTIONS TO
GENERAL MEETING
Westchester United Methodist Church Fellowship Hall
8065 Emerson Ave.
Los Angeles CA 90045
From the North:
Take Sepulveda Blvd.
SOUTH to W. 80th St. Turn
WEST/right. Go about one
mile to Emerson Ave. Turn
SOUTH/left. Go one long
block to W. 80th Place. It is
on the Northwest corner of
Emerson and W. 80th Place.
From the South, East or West:
Take Manchester Ave. to
Emerson Ave. Turn NORTH.
Go about eight blocks to W.
80th Place. Fellowship Hall is
on the Northwest corner of
Emerson and W. 80th Place.
There is street parking and a
small parking lot West of the
church.

